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1 Installation and 
Registration

This section covers the product package, the software and 
hardware requirements for Kurzweil 1000™ and VoiceText™ Text-
To-Speech software. There will also be installation and registration 
instructions for both, as well as steps for installing DECtalk™ 
Access32.

What's in the Product Package?
The following is a general list of contents. The items you receive 
may be a subset of this list, and may depend on whether you are a 
new customer or an upgrade customer, and may depend on which 
version you are upgrading from. 

• The Kurzweil 1000 software CD-ROM.

• The Kurzweil 1000 Reference Guide.

• The Kurzweil 1000 Quick Reference.

• The Version 11 Installation and New Features Guide and the 
Installation cassette tape.

• Two Tutorial cassette tapes. These Tutorial tapes are based on 
Kurzweil 1000 Version 8, but 90 percent of the information is still 
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Part 1. Installation
applicable. You may find that some items on a menu have moved 
and others have been added to accommodate new features, but 
how and where you find the majority of the features remain the 
same.

• You'll also find in the package, the NeoSpeech VoiceText CD-
ROM.

• The Classic Literature CD-ROM and Guide.

• Possibly a Certificate of Ownership bearing the serial number for 
the product.

You can call Kurzweil Educational Systems Customer Service to 
request any of the guides or cassette tapes if they are not included 
in your package. The number is 1-800-894-5374. Please listen for 
and press the extension number for Customer Service.

Some of the material, such as the Tutorial, is available in text file 
and MP3 file format from our web site, www.kurzweiledu.com. 
There is a Kurzweil 1000 Braille Guide for Braille users, which is 
also available upon request.
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Part 1. Installation
Software and Hardware Requirements
The list of software and hardware minimum requirements for 
Kurzweil 1000 and VoiceText follow:

• 500 MHz Pentium III processor or faster. For VoiceText, a 
minimum of 700 MHz is required.

• 128 MB of RAM; 256 MB if you're using VoiceText. 

• At least 500 MB of available hard disk space; and an additional 
625 MB for VoiceText. 

• A CD-ROM drive. 

• A TWAIN-compatible flatbed scanner (check the Kurzweil 
Educational Systems Web site, www.kurzweiledu.com, for a list 
of compatible scanners).

• A Sound Blaster® -compatible sound card with speakers. 

• A Full-size keyboard and/or a 17-button keypad.

• Windows® 2000, XP and Vista operating systems. While most of 
Kurzweil 1000 will work on Windows 98 and ME systems, there 
may be important components or significant features that will not 
be available. The OCR engine titled ScanSoft 15 cannot be used 
in earlier operating systems, so ScanSoft 12 will be installed in 
systems with those operating systems. As a consequence, form 
recognition will not be available in systems with Windows 95, 
Windows 98, or Windows ME. The CD writing facility will only be 
available in systems running Windows 2003, Windows XP or 
Vista. A number of devices supported by the Send To facility are 
not supported under Windows 98, including Book Courier, Book 
Port, and Road Runner.

• And the Kurzweil 1000 product CD-ROM.
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Part 1. Installation
Before Installing Kurzweil 1000
Here are some important notes for consideration before installing 
Kurzweil 1000:

• With Windows 2000, XP and Vista, ensure that you have 
administrative privileges to install Kurzweil 1000. 

• The installation is designed for the novice computer user and 
there will be two options presented to you: one which uses a 
screen reader and the other which uses the Kurzweil 1000 voice 
provided. During the installation process, Kurzweil 1000 will ask 
you to specify which you would like to use. In addition, note that 
the installation process is self-explanatory, and Kurzweil 1000 
provides help throughout the process. 

• After installing Kurzweil 1000, you must register the product. 
Your sessions are limited to two hours until your registration is 
successful. If after 30 days, you have not registered, you will no 
longer have the full product. 

• If you purchased the DECtalk Access32 software speech engine 
option there is a separate installation process. Note, however, 
that if you have DECtalk installed for Kurzweil 1000 Version 8 or 
9, you do not have to re-install it for Version 11.

• If you plan on installing VoiceText, there are two things you 
should be aware of: You must install Kurzweil 1000 Version 11 
first before installing VoiceText, and you must uninstall any older 
version of VoiceText that may be on the system. At the beginning 
of the Installation procedure, Kurzweil 1000 automatically 
checks for the existence of any older version of VoiceText on 
your system. If there is one, Kurzweil 1000 asks if you want to 
automatically remove it.
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• If you have an earlier version of Kurzweil 1000 on your system, 
we recommend that you uninstall it before installing Version 11, 
although it's not necessary to do so. 

• There are a couple of situations in which you may not want to 
uninstall. For instance, you may not want to uninstall Version 7 if 
you want to keep RealSpeak English, or uninstall Version 8 or 
earlier if you want to keep the RTK OCR engine. 

• If Kurzweil 1000 Version 11 is already installed on your system 
and you attempt to perform an install with the product CD, a 
message will indicate that it is already installed and you will then 
have the option of modifying, uninstalling or repairing the current 
installation. 

• Note that Kurzweil 1000 does not install scanners. Use the 
scanner manufacturer's instructions to install the scanner card, 
software, and the scanner itself. If you already have Kurzweil 
1000 installed and you are installing a new scanner, it's not 
necessary to re-install Kurzweil 1000. 

• Check for the latest information on the installation process from 
the product Release Notes in the Readme.txt file on the Kurzweil 
1000 product CD. 

• Depending on your system and the options you select, 
installation may require up to 15 minutes.
Kurzweil 1000 Installation and New Features 5
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Uninstalling Kurzweil 1000 
To uninstall an earlier version of the product, use the following 
procedure. Note, however, that if you want to continue using 
RealSpeak or RTK, do not uninstall. 

1. First open the Start menu from the Windows taskbar. 

2. Go to the Programs menu and select Kurzweil Educational 
Systems.

3. From the Kurzweil Educational submenu, choose Uninstall 
Kurzweil 1000.

Installing Kurzweil 1000 Version 11 
There are two options when installing Kurzweil 1000. You can use 
a screen reader or the Kurzweil 1000 voice provided. By default, 
Kurzweil 1000 installs in your C: drive. If you want to use a different 
drive or system folder, you should use the screen reader installation 
method. 

If you want to use the voiced installation, you must exit any screen 
reader first. 

Before you arrive at the place in the installation procedure where 
you must choose between these two methods, the steps are the 
same, and we'll cover them now. 

1. If you are using Windows 2000, Windows XP, or Windows Vista, 
make sure you have Administrator privileges. 

2. Shut down all applications. Make sure your speakers are 
plugged in, and set the volume to comfortably hear the screen 
reader.
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Part 1. Installation
3. Place the Kurzweil 1000 CD-ROM in your system's CD-ROM 
drive. The auto-install process begins. If it doesn't, choose Run 
from the Windows Start menu. Type: your CD-ROM drive letter, 
followed by :\setup.exe, then press ENTER to start the setup 
program. 

4. If Kurzweil 1000 detects an older version of VoiceText voices, it 
asks if you want to automatically uninstall it. Press the Enter 
key for Yes. Press the Escape key for No. Be aware that you 
must first uninstall any older version of VoiceText in order to 
install a new version.

5. Next, Kurzweil 1000 asks you to choose between voiced 
installation or screen reader installation. To use the Kurzweil 
1000 voiced installation, press the ENTER key. To use the 
screen reader installation, press the ESCAPE key. 

Here the installation process diverges. This guide presents the 
Voiced Installation first followed by the Screen Reader Installation. 
If you are planning on using the screen reader, skip over the 
following section. 

To install Kurzweil 1000 using the voiced installation: 
This procedure assumes that you have completed the Preliminary 
Steps and have pressed ENTER to use the voiced installation. 
Before continuing with the installation, however, note the following 
keyboard keys and their numeric keypad equivalents, which you 
can use throughout the voiced installation process: 

• ENTER key or Accept (top-right key on the keypad) for Yes. 

• ESCAPE key or Cancel (top-left key on the keypad) for No. 

• F1 key or the Help and Status key (bottom-right corner on the 
keypad) for Help; Kurzweil 1000 repeats the prompt. 
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• BACKSPACE key or Rewind (left-most key in row 4 on the 
keypad) to go back to the previous prompt.

Continue the voiced installation with the following steps: 

1. 1. A prompt asks if you want to modify the installation options. 
Press ESCAPE to perform a default installation, or ENTER to 
modify the options. The default installation installs Eloquence™ 
U.S. and U.K. voices, ScanSoft recognition engine, FineReader 
recognition engine for English, the dictionary and various other 
options. 

If you chose to customize your installation options, the system 
asks if you want to install the following items. After you hear the 
item's name, press ENTER to install or ESCAPE to not install it. 
Eloquence American English. Eloquence British English. Six 
Eloquence European languages. For Windows 98 or Windows 
ME, you'll be asked about SSIL, which provides support for 
some hardware speech synthesizers. Finally, you'll be asked 
about bilingual dictionaries, and additional FineReader 
selections. 

2. Next, the system asks whether or not you want Kurzweil 1000 
to start automatically each time you start your system. Press 
ENTER if you do not want Kurzweil 1000 to start automatically. 
Otherwise, press ESCAPE for auto-start. 

3. Press ENTER to confirm your choices and proceed with the 
installation.

4. Sometimes computers need to be shut down and restarted in 
order to complete an installation. If that is necessary, a prompt 
will ask whether you want to Restart your computer now or 
later. (If you choose later, remember that in order to start 
Kurzweil 1000, you should Restart the system first.) If you 
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elected not to have Kurzweil 1000 start automatically, you can 
use CONTROL+ALT+K to start Kurzweil 1000. 

5. At this point, you may remove the Kurzweil 1000 CD-ROM. 

6. Once Kurzweil 1000 starts up, it reads the license agreement. 
Press ENTER to accept the agreement. 

7. Go to the section entitled, Registering Kurzweil 1000, to register 
the product. 

If you want to install VoiceText or DECTalk, you can find the 
instructions after the information on Registering Kurzweil 1000. 

To install Kurzweil 1000 using the screen reader: 

This procedure assumes that you've completed the Preliminary 
Steps and have pressed ESCAPE to use the screen reader for 
installation. Continue the installation with the following steps: 

1. On Windows 98 or ME system, you'll get another prompt asking 
you to select an SSIL hardware speech synthesizer. For all other 
Windows operating systems, go to step 2.

2. Next, you will be asked if you want to install certain bilingual 
dictionaries.

3. If you aren't using a hardware speech synthesizer, press 
ENTER to continue. If you are using a hardware speech 
synthesizer, press the UP/ DOWN ARROW key until you hear 
the desired selection, then press ENTER to continue

4. Next is the request for Customer Information. Here, type your 
user name.

5. Next, press the TAB key to go to the organization name text 
box. This is an optional entry. If you are using Windows XP or 
Kurzweil 1000 Installation and New Features 9
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Windows 2000, there's an additional option: "Install this 
application for: Anyone to use..., or Only Me .... "TAB to go to 
this option, and select the Anyone to use option. Press ENTER: 
to continue. 

6. Next, specify if you want a Complete or Customized setup. 
Complete is the default option. 

If you want the Complete install: Press ENTER and go to step 8. 

7. If you'd rather customize your install, or want to place Kurzweil 
1000 on a different drive than the default C drive or in a different 
folder: Press TAB to select Customized. 

The Custom Setup dialog opens. The Custom option installs just 
the files you leave selected in this box. The following are 
changes you can make:

To remove the feature files you don't want, use the UP/DOWN 
ARROW keys to go through the list, stop when you hear the 
name of the file you don't want and press the SPACEBAR: key. 
You'll hear, "This feature will not be available" for selections that 
are removed. You cannot remove Main files as they are 
necessary for Kurzweil 1000 to function. 

To change the drive or location in which to place Kurzweil 1000, 
select Main Files, and then press TAB to go to the Change 
command. Press ENTER. In the Change dialog that opens, type 
the name of the desired drive and or location, or press SHIFT 
+TAB to select another location. Press ENTER: to close the 
dialog. 

When you are done customizing the setup, press ENTER to 
continue with the installation. 
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8. Next, the system asks whether or not you want Kurzweil 1000 
to start automatically each time you start your system. Press 
ESCAPE for auto-start. Press ENTER if you do not want 
Kurzweil 1000 to start automatically. 

9. The system may prompt you to Restart the computer. If it 
doesn't, or after you have restarted your computer, you can use 
CONTROL+ALT+K to start Kurzweil 1000. 

10.Once Kurzweil 1000 starts up, it reads the license agreement. 
Press ENTER to accept the agreement. 

11.Go to the section entitled, Registering Kurzweil 1000, to register 
the product. 

If you want to install VoiceText or DECTalk, you can find the 
instructions after the information on Registering Kurzweil 1000. 
Kurzweil 1000 Installation and New Features 11
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Registering Kurzweil 1000 
When you first install Kurzweil 1000, it is in Demonstration mode. In 
this mode, all features will be available, but each session is limited 
to two hours. Worse, after 30 days, the product will no longer be 
available to you. To use the full product right away, it's important that 
you register. 

Before you register, here are a few things you must do and know:

1. Consider how you want to register. You can register Online 
through the software if your system has an Internet connection, 
or by telephone or by floppy diskette. If you plan on using the last 
method, be sure to have a diskette ready.

2. Also have the serial number ready. We provide this in both print 
and Braille in the following places: on your Certificate of 
Ownership card enclosed with the documentation packaging, 
(this is a square card with the upper-right-corner cut away), on 
the outside of the product box, and on the CD holder. 

If you are upgrading from Version 7, 8, or 9 to Version 10, you 
should use the same serial number with which you registered 
previously, and the system will remember that number for you. 

If you are upgrading from an earlier version than Version 7, you 
will receive a new serial number. 

If you purchased multiple Kurzweil 1000 licenses, the serial 
number for the set is the same. 

During the registration process, you can type or scan the serial 
number from any of the sources mentioned above.

3. Note the Kurzweil 1000 Customer Service contact information. 
In the U.S. and Canada use 1-800-894-5374. For international 
Kurzweil 1000 Installation and New Features 12



Part 1. Installation
calls use +781-276-0600. Each one of the registration methods 
is straight-forward, but, if after repeated unsuccessful attempts, 
you still need assistance, please call us.

Preliminary Registration Steps 

1. In Kurzweil 1000, open the Help menu. You can use ALT+H. 
Then press G to select Register. 

The first of multiple Registration dialog boxes opens. Some of 
the dialogs you'll use during the registration procedure have the 
Next and Back commands. Press ALT+N or the ENTER key to 
go to the next dialog and ALT+B or ESCAPE to go back to the 
previous one. To get from one item to another, press the TAB 
key. In the first dialog, your cursor is in the Serial Number box. 

2. Type in or scan the serial number. 

If you've registered before, the Serial Number box already 
contains the number. 

Otherwise, to scan the serial number, place the Certificate of 
Ownership card, product box, or CD holder, face down in the 
top-left corner of the scanner. Press the TAB key to go to the 
Scan command. When you hear "Scan" press ENTER. Kurzweil 
1000 scans the serial number directly into the Serial Number box 
in this dialog. 

3. Press TAB then press ENTER to open the next dialog box. 

Kurzweil 1000 asks you to select the registration method you 
want to use. Your cursor is in a list box and the options include: 

Online, Telephone, and Diskette. The Online option is the 
default.
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Use the UP or DOWN ARROW to select the desired option. 

4. Press ENTER to open the next dialog.

5. Skip to the instructions for the registration method you selected. 

Registering Online 
To use this method, your system must have an Internet connection. 
If you have a firewall, it must be configured to accept Internet 
access requests from Kurzweil 1000. Otherwise, you will receive 
messages from the firewall indicating that an unauthorized 
application is attempting to use the Internet. You will need a screen 
reader or an assistant to configure the firewall, or you may call 
Kurzweil 1000 Technical Support. The numbers are: 1-888-995-
9905 or 1-800-894-5374. Please listen for and press the Kurzweil 
1000 Technical Support extension number.

1. After selecting online registration, one of two things can occur:

• If you have an existing serial number, and it is associated with 
only one account, Kurzweil 1000 congratulates you and tells you 
that you have been automatically registered. It then asks if you 
want to update your account information. If you answer Yes, 
Kurzweil 1000 automatically fills in your account information in 
subsequent Registration screens. Make the desired changes 
and press ENTER to complete registration.

• Otherwise, a dialog opens with the cursor in the Account Type 
box. 

2. If a dialog opens, you can select New or Existing in the Account 
Type box.

Select New if you are registering for the first time or with a new 
serial number. Then go to step 3.
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Select Existing if you’ve registered before. Go to step 3.

Select Existing - Request Information if you've registered before, 
but have forgotten your password. Press ENTER. 

When Kurzweil 1000 finds your information, it sends the details 
to your e-mail account. Check your e-mail for the information, 
then begin the online registration process again. This time, 
select Existing in the Account Type box.

If Kurzweil 1000 is unable to find your information, you may have 
to call Kurzweil Educational Systems Customer Service at 781-
276-0600 or toll-free at 800-894-5374 in the U.S. and Canada. 

3. In the Account name text box, type your account name. Then 
TAB to type your password in the Password box.

If you are creating a new account, pick a unique name that’s 
easy to remember such as your e-mail address. After typing your 
password, TAB to retype it in the Confirm Password box.

Note: It’s a good idea to note this information for future 
reference, as when you upgrade to the next version.

4. Press ENTER to connect to the Kurzweil Educational Systems 
Online Registration page. 

The system verifies that you are online, the server is up, the 
account exists, and that the password is correct. If it finds 
information that is incorrect or incomplete, it prompts you to 
make the necessary changes. 

Your cursor is in the first of a few online registration dialog boxes. 
The system prompts for information that is mandatory. 

5. Provide or change information. Press ENTER to proceed 
through these dialog boxes. 
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6. Press ENTER when you are done. 

If registration is successful, Kurzweil 1000 congratulates you. 
The full Kurzweil 1000 product is now activated.
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Registering by Phone 
Two notes regarding phone registration:

• If you are installing and registering Kurzweil 1000 on multiple 
machines, then we recommend using the Systems Code 
Worksheet at the end of the printed version of the Installation and 
New Features Guide. You can note the systems codes, serial 
numbers and unlock codes, which can greatly expedite the 
registration process. 

• Customer Service representatives are available to take your 
registration between 8:00 a.m. and 4:00 p.m. Eastern Time. The 
Customer Service telephone numbers are: 1-800-894-5374 in 
the U.S. and Canada; +781-276-0600 for international calls. 

The phone registration process follows:

1. After selecting phone registration, another dialog opens. 
Kurzweil 1000 tells you the telephone number for Kurzweil 
Educational Systems Customer Service and provides the serial 
number and systems code for this installation. 

Call the telephone number, and give the representative the serial 
number and systems code. If you need to hear either of these 
codes again, use the TAB key or SHIFT plus TAB.

2. The representative will give you an unlock code number to use 
in activating this Kurzweil 1000 installation. Note this unlock 
code number. 

3. Your cursor should be in the Unlock Code box. If it is not, press 
TAB until you hear "Unlock Code." 

4. Type the unlock code number. 

5. Press ENTER. 
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6. If registration is successful, Kurzweil 1000 congratulates you. 
Your Kurzweil 1000 product is now activated.

Register Using Floppy Diskette 
The general procedure for registering using floppy diskette consists 
of the following steps:

• Place registration information onto a floppy diskette. Upon 
completion, the system extends the original demonstration time 
by an additional 60 days. You can continue to use the product for 
two hours at a time until you activate the product.

• Mail the registration diskette to Customer Service at Kurzweil 
Educational Systems. When we confirm your registration 
information, we send you an Activation diskette. Allow two to 
three weeks for delivery.

• When you receive the Activation diskette, use it to activate the 
full product. 

To place the registration information on a floppy diskette:
Before you begin, ensure that you have a floppy disk drive on your 
system, and that you have a blank, formatted diskette ready. 

After selecting Diskette registration, the first in a series of dialogs 
opens, asking for your name and address, and for some product 
purchase information. 

1. Follow the prompts to enter information. The system tells you 
what information is mandatory. Use TAB to go to the next field. 
Use ENTER to go to subsequent dialog boxes. 

2. Insert the floppy diskette into the floppy drive. Then press 
ENTER. This saves all registration information to the floppy 
diskette.
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Note: You may want to create a duplicate registration diskette as 
a backup if the original should get lost in the mail.

3. Eject the diskette, and mail it to Kurzweil Educational Systems, 
100 Crosby Drive, Bedford, MA 01730. Attention Customer 
Service. 

When you receive your Activation diskette from Kurzweil 
Educational Systems, perform the Activation steps below.
Kurzweil 1000 Installation and New Features 19
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To Activate Kurzweil 1000 using the Activation Diskette:
1. Insert the Activation diskette into the floppy drive. 

2. Start Kurzweil 1000.

3. Choose Activate from the Help menu. 

Kurzweil 1000 verifies the information on the Activation diskette, 
and then fully enables use of the product. 
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Installing VoiceText
The VoiceText CD-ROM contains Paul and Kate English-speaking 
voices. It's important to note that you must first install and register 
Kurzweil 1000 prior to installing VoiceText. If Kurzweil 1000 detects 
an earlier version of VoiceText on your system, you will receive a 
message asking you if you want Kurzweil 1000 to automatically 
remove the older version. If you answer No, be sure to uninstall it 
using the following procedure:

1. Open the Start menu from the Windows taskbar. 

2. Go to the Programs menu and select the Kurzweil Educational 
submenu. 

3. Choose Uninstall the VoiceText program.

To install VoiceText, simply follow the prompts. The VoiceText CD 
uses a voiced installation.
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Installing DECtalk Access32
Before installing DECTalk, review the following notes:

• If you already have DECtalk installed on your system, it's not 
necessary to re-install. 

• You can install the DECtalk product either before or after 
installing Kurzweil 1000. 

• This installation process uses keyboard keys only; there are no 
keypad equivalents. 

• Be sure you have the Kurzweil 1000 DECtalk CD and the 
DECtalk key disk. 

You’re ready to perform the installation:

1. Place the CD in the CD drive. 

2. Disable the Kurzweil 1000 auto installation by holding down the 
SHIFT key on the keyboard until the CD stops spinning. 

3. Navigate to the DECtalk folder in the CD folder. 

4. Press the UP/DOWN ARROW keys until you find the 
"setup.exe" file. Press the ENTER key to start the installation.

5. When prompted, insert the key disk into the floppy disk drive. 
You'll hear "DECtalk successfully installed" when the process is 
complete.

If you should want to uninstall DECTalk, use the Add/Remove 
Programs from the Windows Settings Control Panel.
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Exploring Kurzweil 1000
You may want to explore the following helpful resources:

First, in the Readme.txt file in the root folder of the CD, you'll find 
information on the latest features and changes in Kurzweil 1000.

The second is the \Extras folder, which contains applications that 
some of our customers have found to be useful. 
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2 Tips for New Users

There are a couple of ways to learn how to use Kurzweil 1000: 

• Go through the taped tutorial included in the product package. 
You can also download the Tutorial in MP3 format from 
www.kurzweiledu.com. 

• Or you can browse the Online Manual. 

This Tips chapter, however, is designed to give you a jump start.

Keypad or Menu? 
There are two different approaches to using the Kurzweil 1000. If 
you are comfortable with a computer keyboard and already use 
Windows applications, you might want to use the Kurzweil 1000 
menu user interface. 

If you want a simpler introduction to the product, start by learning 
the numeric keypad user interface. There are built-in help systems 
and documentation for both approaches. You may not want to limit 
yourself to one or the other. If you are a Windows user and like 
using the computer keyboard, consider using the keypad interface 
as a way to quickly access frequently used functions.
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Using the Numeric Keypad
The most important key on the keypad is the Help and Status key in 
the lower-right corner. To find out a key's function, tap the Help and 
Status key then tap a key you want to identify. 

To get a longer, more descriptive explanation of a key's use, tap 
Help and Status, then press and hold down the desired key. 

Some keys have different functions when they're shifted. You can 
get help on a key's shifted function by tapping the Help and Status 
key, then holding down the Shift key and pressing the key for which 
you'd like information. 

Four other frequently used keys are: 

• Start and Stop Scanning. It's the long vertical key above the Help 
and Status key. 

• Start and Stop Reading. It's the long horizontal key in the lower-
left corner of the keypad. This key also acts as a Shift key. 

• Cancel, in the upper-left corner, cancels an action that requires 
confirmation. 

• Accept, in the upper-right corner, completes an action that 
requires confirmation.

At any time, you can get Help from the Online Manual by holding 
down the Shift key (the long horizontal key in the lower left corner 
of the keypad) and pressing the Help and Status key.
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Using the Menu System
The following are general notes about using the Menu System:

• Pressing the ALT key on the keyboard gives you access to the 
main menu bar. 

• You can then use the LEFT and RIGHT ARROW keys on the 
keyboard (not the keypad) to move among the main menus. As 
you move to each menu, Kurzweil 1000 speaks the menu name.

• Use the DOWN ARROW key to open a menu and move through 
its items. Kurzweil 1000 speaks a message if an item opens a 
dialog, if it has a submenu, or if there is a shortcut keystroke. Use 
the RIGHT ARROW key to access a submenu. 

• To select a menu item, press the ENTER key on the keyboard. If 
the item has a dialog, that action opens the dialog.

• To get information about a menu item or any part of a dialog, 
press the F1 key. 

• To access the online manual, select Open the Manual from the 
Help menu.

There are also mnemonics, or letter keys that you can press with 
the ALT key, for speedy selection of menu items. For instance, 
pressing the ALT key, then the letter H key for the Help menu, and 
the letter O key for Open the Manual opens the Kurzweil 1000 
online manual. As you become familiar with the Kurzweil 1000 
menus and their items, using mnemonics will become second 
nature.

Consider memorizing shortcut keys for menu items you use 
frequently. Shortcut keys are one to two keys that you press to 
perform an action. For instance, the F5 Function key Starts and 
Stops Reading, the F9 key Starts and Stops Scanning, and the F1 
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key provides help. You can also use standard Windows shortcuts 
such as the Control key plus letter O to open a file.

Another useful Kurzweil 1000 specific shortcut is Shift plus F9 to 
recognize currency. While reading, the following shortcuts can be 
very handy: F12 and F11 increases and decreases reading speed, 
respectively. Control plus D defines a word. Control plus F lets you 
find text and Control plus G takes you to a desired page. 

For a comprehensive list of shortcuts, use the Quick Reference 
from the Help menu by pressing ALT plus H, then Q any time while 
you are using Kurzweil 1000.

Once you have opened the manual, you can, of course, just read it 
using F5. But since it is a lengthy document, you might prefer to use 
an index. Press CONTROL+R to access a list of bookmarks. You 
can move among those bookmarks with the Up and Down Arrow 
kes. Bookmarks have a structure like an outline. The topmost level 
will contain chapter titles. You can burrow deeper into the details of 
a chapter by pressing the Right Arrow, which takes you to 
subchapter titles. When you have found a subject that interests you, 
press Enter, and you will be taken to that section in the manual. 
Finally, CONTROL+F, or Find, allows you to search for a word or 
phrase in the manual, or in the list of bookmarks.
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Starting and Shutting Down Kurzweil 1000
There are three additional helpful shortcuts to know. If you do not 
have Kurzweil 1000 starting up automatically when you start up 
your computer, you can start Kurzweil 1000 by pressing Control 
plus Alt plus K. 

To shut down Kurzweil 1000 using the keypad; press the Cancel 
key twice, followed by the Accept key. To do so with the menu 
system, use the Exit menu item under the File menu, or ALT+F, and 
then X. To power off your computer, which you can do only through 
the keypad, press the Cancel key three times followed by the 
Accept key.

Finding Help and Information
Wherever you are in the product, Kurzweil 1000 provides audio 
feedback through the Verbosity feature and the messaging system. 
However, the following is a short list of the many ways in which you 
can find additional Help and information:

• The F1 key gives you information about the current control.

• The F2 key provides Help for the current dialog box.

• For the Online Help Manual, press ALT+H, then O. In the 
manual, you can use Bookmarks and the Find feature to go to 
and/or search for the information you want. Press CONTROL+R 
to access Bookmarks. You can move among bookmarks with 
the Up and Down Arrow keys. Bookmarks have a structure like 
an outline. The topmost level will contain chapter titles. You can 
burrow deeper into the details of a chapter by pressing the Right 
Arrow, which takes you to subchapter titles. To go to a desired 
subject, press ENTER. You can use CONTROL+F, or Find, to 
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search for a word or phrase in the manual, or in the list of 
bookmarks. Note that on the keypad, pressing the Shift (the long 
horizontal key in the lower left corner of the keypad) and the 
Help and Status keys opens the manual. 

• There's also a Quick Reference, which provides a 
comprehensive list of shortcut keys. Press ALT+H, then Q to 
open the Quick Reference.

• If you want information about the version of Kurzweil 1000 that 
you are using, press ALT+H, then A.

• Finally, a good way to find help is through fellow users. You can 
do this by signing up for the Kurzweil 1000 e-mail listserv at 
www.kesi.com. In the main product page, find Listserv under 
Support in the right-hand bar.
Kurzweil 1000 Installation and New Features 28



3 Version 11 New 
Features 

For the most up-to-date feature information, refer to the Readme file 
on the product CD-ROM.

The following is a quick list of what’s new in Version 11. For 
additional details, go to the Summary of New Features section. 
Because the requirements of and suggestions from our customer 
base are what drive the feature set, many of you will find your ideas 
translated into real features and functions.

• Among the most exciting new features are Forms Recognition, 
the Appointment Calendar application, Document and Settings 
Linkage, Writing Files to CD, Scanner Button Support, and the 
addition of Conversion Settings.

• As always, Kurzweil 1000 has the latest OCR engines, 
FineReader 8 and ScanSoft 15 and we continue to improve on 
the scanning and recognition processes. This time, we added 
Recognition Optimization, Table Output in HTML and DAISY 
files, and Reading Newly Recognized Pages.

• You’ll find numerous other enhancements in dictionary lookup, 
audio files, search, reading in lists and dialogs, Encyclopedia 
sources, and even in Time and Date.
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Wondering what we might include in the next version? Have an idea 
for a new feature or an enhancement? Sign up for the Kurzweil 
1000 listserv on www.kesi.com, and give us your feedback.

In the summary of each new feature that follows, you'll find general 
information on how to use the functionality. For complete details, go 
to the online reference manual. 

Form Recognition
You can use Kurzweil 1000 to scan and recognize most types of 
forms. Kurzweil 1000 automatically uses the ScanSoft engine, 
keeps an image of the page and presents you with the fields, labels, 
boxes, text areas, as well as the positions of those items, and in an 
appropriate reading order. You can read, save, edit, cut and paste 
in forms, just as you do in any document. 

There are two ways to fill in a form. You can use the Fill a Field 
command from the Edit menu, ALT+E, then L, shortcut 
CONTROL+F3. If you have some vision or have an assistant, you 
can fill out the form using the image of the form by choosing Show 
Image from the Tools menu (ALT+O, then W). The shortcuts and 
functions presented in the general steps are applicable when filling 
forms using either method. When using Show Image, you can 
magnify the image, invert it, read the recognized text, move among 
the form fields and select or type in responses as you would in when 
using Fill a Field.

The general steps for working with forms are:

• Scan the form using the Scan as a Form command from the 
Scan menu; the mnemonics are ALT+S, then M. Scanning a 
page as a form only affects one page at a time. This is true even 
if you are using a document feeder, in which case, place one 
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page at a time in the document feeder when scanning multi-
page forms.

• If you are reading a page and determine that it should have been 
recognized as a form, use Rerecognize a Form from the Scan 
menu, ALT+S, then E. Note that Rerecognize a Form will not 
work if the page you have open does not have an associated 
image.

• Read through the form document to orient yourself and get a 
general idea of where there might be fields you will need to fill, 
and the context of those fields. By default, when Kurzweil 1000 
encounters a field, you hear a chime. F5 starts and stops 
reading, and you can move in the text in the usual manner.

• Fill in the form by choosing the Fill a Field command from the 
Edit menu, ALT+E, then L, or use the shortcut CONTROL+F3. 
This brings up one or more Form Fill dialogs in a series, and 
Kurzweil 1000 guides you through the fields. If there are multiple 
dialogs, you can use Back (ALT+B) or Next (ALT+N) to 
navigate, in either case Kurzweil 1000 saves the changes you’ve 
made. You can TAB and SHIFT+TAB to move through the 
fields. If there are check boxes or list boxes, Kurzweil 1000 
announces them and their status. 

• When you have completed filling in a form, save your edits and 
close the Form Fill dialog by pressing ENTER or ALT+O. Your 
cursor returns to the open document. To close the dialog without 
saving edits, press ESCAPE or ALT+C.

• You can use the Save function to save the document.The 
information you have filled out in the recognized fields is saved, 
along with the recognized text and the image of the form.

• You can use the Print command to print the image file 
containing the contents of the fields you have filled out. In the 
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Print dialog, TAB to the Use Images option or press ALT+I and 
select Yes. Then press Enter.

There’s more you can do while working with forms, including 
rerecognizing a form, and adding a signature.

• If you have a signature file, you may add it to any form field that 
is a text box and that contains a variable number of characters. 
With your cursor in the desired field, press CONTROL+UP or 
DOWN ARROW until you reach the desired signature file. For 
details on signature files, go to Scanning, Creating and Inserting 
a Signature File in the section entitled, Additional Recognition 
and Scanning Features.

• You may encounter fields that are unlabeled or uninformative; to 
hear the recognized text found near the field, press 
CONTROL+X. Press it again to hear additional text.

• If you want to hear the state of a field, press F7. For additional 
information about the field, such as its type, label, position and 
size, press SHIFT+F7.

• Some text fields may contain multiple lines. Use 
CONTROL+ENTER to end one line and begin another. If you 
are using Show Image to fill out the form, you may use the 
ENTER key instead.

Notes: 

• If you are using a document feeder, place only one form page at 
a time in the feeder, as Scanning a page as a form only affects 
one page.

• It's possible to change the chime or message for a form field. To 
do so, go to the Verbosity setting called Reading Past a Form 
Field. 
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Additional Recognition and Scanning Features
Scanning, Creating and Inserting a Signature File. Signature 
files enable you to insert a scanned image of your signature into a 
document. You can also add a signature into any form field that is a 
text box. For details on adding a signature to a form, go to the Form 
Recognition section.

Note that signature files are saved in TIFF format in a folder called 
"Signatures" in the Kurzweil Educational Systems/Images directory.

To scan and create a signature file:

1. First, write your signature in the upper left portion of a blank 
piece of paper, making sure it is not too close to the edges, and 
that there is not too much spacing between the different parts of 
the name. 

2. Next select Create a Signature File from the Scan menu. 
(ALT+S, then C).

3. Place the paper on the scanner following directions from 
Kurzweil 1000, and press Enter.

4. A dialog appears displaying the signature. You can increase or 
decrease magnification in this dialog by using CONTROL+UP 
ARROW and CONTROL+DOWN ARROW, respectively. If you 
are satisfied with the current signature, you can accept it by 
pressing Enter or ALT+O for OK. To discard the current 
signature, press Escape or ALT+C for Cancel.

5. After accepting a signature, another dialog appears asking you 
to enter the name you want for the signature file. If you would 
rather overwrite an existing signature file, use the UP/DOWN 
ARROWs to select the desired one.
Kurzweil 1000 Installation and New Features 31



Additional Recognition and Scanning Features
To insert a signature file into a document, place the cursor where 
you want to insert the signature. Choose Insert Signature from the 
Edit menu (ALT+E, then I). If there are multiple signature files, use 
the UP or DOWN ARROW key to select one from the list.

Scanner Button Configuration. Some scanners come with one or 
more buttons. You can now assign those buttons to functions within 
Kurzweil 1000, such as starting a scan, starting Kurzweil 1000 
Photocopier or FAX applications. Note that this works only if the 
scanner manufacturer supplied software conforms to certain 
Microsoft specifications; not all of them do.

To configure Kurzweil 1000 Scan, press the desired scanner button; 
select Scan with Kurzweil. If you have both Kurzweil 1000 and 
Kurzweil 3000 applications on your system, and both are currently 
running or neither are running, you will have to specify with which 
of the two you want the Scan function associated. 

To set the next button for either Scan and Print or Scan and Fax, 
press the desired button and select the desired option. Once 
configured, you can press the button to perform the designated 
function. For Scan, Kurzweil 1000 begins scanning and its window 
opens if it isn’t already. For Scan and Print, the Kurzweil 1000 
Photocopier application window opens and you can specify the 
number of copies and complete the Make Copies process. For 
Scan and Fax, the Kurzweil 1000 Fax application window opens 
and you can specify a recipient and complete the Send process. 

If you want to reconfigure the buttons, use the ScanConf application 
in the Diags folder in the Kurzweil Educational Systems folder in 
your Program Files.

Recognition Optimization. Like Optimize Scanning, Optimize 
Recognition directs Kurzweil 1000 to automatically find the best 
settings for producing optimal OCR results for an open page. 
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Accessible from the Scan menu, this command opens a dialog 
containing two settings: Text Quality and Engine; both are set by 
default to Optimize. 

When Kurzweil 1000 completes the recognition, you can opt to 
keep the newly recognized page by pressing ENTER or ESCAPE 
to discard it. 

Because this feature works with a page image, the Keep Images 
setting in General Settings must be enabled when scanning the 
page. 

Reading Newly Recognized Pages. It's often helpful to be able to 
listen to material as you scan, for example when you are sorting 
through the mail. 

To set Kurzweil 1000 in this mode, go to General Settings (ALT+T, 
then G). In the General Settings tab, press ALT+R to go to Read 
Newly Recognized Pages and use the DOWN ARROW to Enable 
the setting. 

This setting is savable.

Scanning from Microsoft Word. You can use Kurzweil 1000 to 
scan a page while in a Microsoft Word document. Kurzweil Scan 
and Recognize is on the Insert menu. It’s also possible to choose a 
scanner from Microsoft Word from the Tools menu.

Expanded Use of Batch Scanning Prefix. This setting is in the 
Scanning Settings tab, mnemonic P. You can now use 
backslashes and colons to specify the name of a folder to store 
image files or of a source folder containing files to scan. If you 
specify a folder or subfolder that does not exist, Kurzweil 1000 
creates one.

Scan Time. There’s a way to determine the time elapsed between 
the press of the scan button and when the scan is complete. Open 
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the Recognition Statistics dialog for the Last Page (mnemonics 
ALT+T, then O and L), and because Scan Time is the first item in 
that dialog, Kurzweil 1000 will announce the time in seconds.

New ScanConf Option. By default, Kurzweil 1000 continually shifts 
focus back to itself during a scanning session. Suppose, however, 
that you prefer to use Kurzweil 1000 as a background application, 
scanning with a document feeder or using the scanning hot key. You 
can opt to suppress this feature by changing the setting labeled, 
Keep Kurzweil in Foreground option to Never. This setting is in 
the ScanConf application, which is located in the directory, Program 
Files\Kurzweil Educational Systems\Diags.
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New Appointment Calendar Application
The Kurzweil Appointment Calendar is a simple-to-use application 
that allows you to create and receive appointment reminders. It 
automatically installs on your system when you install Kurzweil 
1000. 

There are two ways to launch the Appointment Calendar 
application. You can select Appointment Calendar from the File 
Launch submenu, mnemonics, ALT+ F, then L and M, or use the 
default shortcut keys CONTROL+ALT+A. Note that it's possible to 
change this default shortcut in the Tools Preferences dialog, 
ALT+T, then P. 

After running the application for the first time, the application is 
accessible from the Windows Task Tray and you can use the Right-
Click method to access commands. Appointment Calendar will 
continue to run in the background automatically every time you 
restart your computer unless you opt to not load the application. 

You may decide that you do not want the Appointment Calendar, for 
instance, you may already use another application, such as Outlook 
for your appointments. In that case, you can select to not load it. 
You do this by opening the Tools Preferences dialog, and 
unchecking the Load Appointment Calendar at Startup option.
To create and edit appointments:
There are two ways of accessing the Add and Edit Event dialogs. 
You can:

• Use the Right-Click method to choose New Event for adding a 
new event, or Show and Select for editing an existing event.

• Or you can use the default shortcut keys CONTROL+ALT+A, or 
hot keys that you may have set.
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This opens the main window, in which you will find three menus: 
File, Tools, and Help. From the File menu, you can Add, Edit, 
Delete, Close the window without stopping the application, and Exit 
which closes the window and stops the application. The Tools menu 
contains two items: Preferences which lets you set the Startup Hot 
Key options and Select Notify Sound which enables you to select 
sound files from your system for the reminders.

The cursor will be in the Events box. Do one of the following: press 
CONTROL+N to Add a new event, or press CONTROL+E to Edit 
an existing event.

The Add Event or Edit Event dialog opens, and the cursor is in the 
event Name box.

If you are adding an event, use the UP/DOWN ARROW to go 
through the list of templates and select the one that is most similar 
to the type of event you want to create.

Specify, enter or change the appropriate information, then press 
ENTER.

Once you’ve created your appointments, the application displays 
their reminder dialogs at the specified dates and times, alerting you 
to the up-coming event. To hear the event message again, press 
F7. 

In the Reminder dialog, there is a Remind Again check box, which 
is unchecked by default. Somewhat akin to the "Snooze" button on 
your clock alarm, you can check the Remind Again box, then select 
the timeframe, minutes, hours, or days, in which you want to be 
reminded again. If you OK without checking the Remind Again box, 
Kurzweil 1000 removes it from the event list if it's a one time event. 
If it's a repeating event, the event will stay in the list and the 
reminder will occur again based on your specifications.
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To change the Appointment Calendar Preferences press ALT+T, 
then P, or use the Right-Click method and select Preferences. 
There are two items in the Preferences dialog: 

• Load Appointment Calendar at Startup which is checked by 
default. Uncheck it if you do not want or need to use the 
application.

• Hot Key option enables you to reset the default 
CONTROL+ALT+A for opening the main application window to 
another letter key in the list.

To delete an event, select it from the Events list in the main 
Appointment Calendar window, then press the DELETE key. 

New File Features
Support for Bookmarks, Notes and Last Reading Position in 
any saved file format. Kurzweil 1000 now retains bookmarks, 
notes and last reading position in any document that you save in 
any file format, not just .kes, so you can enjoy those features in a 
Word document, an RTF file or any other file type that you can open 
in the program. You can lose these features in documents that are 
not in the .kes or DAISY .opf formats when you move it to another 
computer, or alter it in any way outside of Kurzweil 1000.

Linking Documents and Settings
You can link scanning and certain other settings to documents. With 
this setting enabled, Kurzweil 1000 creates a settings file whenever 
you close an existing document or whenever you change settings. 
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To enable Link Documents and Settings:

1. Open the Configurations Settings tab (ALT+T, then F). 

2. In the dialog, go to Link Documents and Settings by pressing 
ALT+I. The options are as follows:

Disabled, which is the default.

Scanning Settings Only, which loads scanning, recognition 
and scanner margin settings whenever you open a document. 

Most Settings, which loads the settings associated with the 
Scanning Settings Only option, in addition to Voice, Reading, 
General and Verbosity settings whenever you open a document 
or whenever you switch from one active file to another.

Writing Files to a CD. If your system has a CD burner and is 
running Windows 2003, Windows XP or a more recent operating 
system, you can find the CD Writing Tasks submenu from the 
Tools menu by pressing ALT+O, then C. 

In addition to adding and writing files to CD, you can check the 
status, remove files, erase the CD and write a folder directly to the 
CD bypassing the queue, which is a timesaver when copying CDs.

The general procedure follows:

1. Be sure you have a writable CD in the CD burner.

2. If you have multiple CD drives that can write CDs, press L from 
the CD Writing Tasks submenu to Select a Drive, otherwise 
go to the next step.

3. Add Files to the queue by pressing A from the CD Writing 
Tasks submenu. In the File dialog, select the desired folder, file 
or files. 
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4. Start Writing the files to the CD by pressing W from the CD 
Writing Tasks submenu.

To obtain status before you begin writing to CD, press S from the 
CD Writing Tasks submenu. You may hear some or all of the 
following information: total size of the files, whether or not a CD is 
in the drive, and how much free space is available on the CD. 

To remove files from the queue, press R. 

To erase all the files from a CD, press E.

To write directly to the CD, press D, then select the folder whose 
contents you want to write directly to the CD.

Note: the selected drive is a saveable setting. 

The Conversion Settings Tab. This dialog contains settings for 
how you want files in particular formats to open and/or to be saved. 
There are two main controls: Action, mnemonic A and Format, 
mnemonic F. In the Action list, select Opening Documents or 
Saving Documents. In the Format list, the selections for Opening 
Documents are Text, Braille, RTF, PDF, Other, and for Saving 
Documents, the list consists of Text, Braille and Other.
Subsequent controls depend on the selections you make for the 
Action and Format. The following controls and their associated 
mnemonics are organized by the different Action/Format 
combinations:

When Opening Text Documents, the settings are:

Split Long Page, mnemonic P. Select Enabled or Disabled. 
Enabled is the default which inserts page breaks.

Paragraph Analysis, mnemonic A. Select Enabled or Disabled. 
Enabled is the default which evaluates whether each end of line 
mark should be treated as a space or as an end of paragraph. In the 
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Disabled state, each end of line mark is treated as an end of 
paragraph.

Language, L. Choose Default or a language from the list. Left on 
Default, Kurzweil 1000 uses the language supported by the 
currently selected Reading Voice to read the Braille document.

When Opening RTF Documents, there is only one setting: Split 
Long Page, mnemonic P. Select Enabled or Disabled. Enabled is 
the default which inserts page breaks.

When Opening PDF Documents, there are two options in a list for 
the Emphasis setting (mnemonic E): Recognition of Images and 
Extract Text. PDF files can contain any combination of images and 
text. Sometimes, a PDF page may have embedded graphics, 
pictures and text. The results you get depend on your selected 
recognition engine and the Emphasis you choose.

By default, the Emphasis is set to Recognition of images. 
Depending on the recognition engine you are using, this method 
recognizes or extracts all the text, and could potentially recognize 
everything on the page including labels that are embedded in a 
graph. This method may be slow but it produces complete results. 

If you want to only extract the text, select the Extract Text option. 
This method provides quick and accurate results, however, it 
ignores pictures, graphics and/or embedded text. Note that if there 
is no embedded text on a page, you could get a blank page or the 
results of image recognition depending on the recognition engine 
you are using.

When Opening Documents with the Other option, there is only one 
setting: Use Microsoft Office for Conversions, mnemonic M. 
Select Enabled or Disabled. The default is Enabled, which uses 
Microsoft Office, if it is on your system, to convert certain types of 
documents to RTF, which Kurzweil 1000 then converts to KES. In 
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the Disabled state, Kurzweil 1000 uses Stellent’s Outside In™ 
technology to perform the conversion to RTF.

When Saving Text Documents, the settings available are: 

Add a Blank Line after each paragraph, mnemonic B. The default 
is Disabled, which adds blank lines only if they are present in the 
original document. To add blank lines, select Enabled.

Indent the First Line of each paragraph, mnemonic I. The default 
is Disabled, which adds indents only if they are present in the 
original document. To add indents, select Enabled.

Spaces used for a First Line Indent, mnemonic S. If you opted to 
add indents in the previous setting, type a value from 0 to 10 for the 
number of spaces you want for the indents. Zero is the default, and 
it adds a Tab space.

Line Endings, mnemonic L. Select Preserve, Remove, or Wrap 
to Fit. The default, Preserve, retains the length of the text line that 
is in the original page scanned in Kurzweil 1000. Remove directs 
Kurzweil 1000 to make each text line equal to a paragraph. Wrap to 
Fit allows you to ensure that no text line will exceed a certain 
number of characters, by inserting line endings between words 
within paragraphs as necessary.

Maximum Width of Each Text Line, mnemonic M. If you opted to 
have Line Endings Wrap to Fit, in the previous setting, type a value 
from 30 to 250. The default is 80.

When Saving Braille Documents, the settings available are: 

Type of Braille, mnemonic T. Select Grade 1 or Grade 2.

Language, L. Choose Default or a language from the list. Left on 
Default, Kurzweil 1000 uses the language supported by the 
currently selected Reading Voice to associate with the Braille 
document.
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When Saving Documents with the Other option, there is only one 
setting: Use Microsoft Office for Conversions, mnemonic M. 
Select Enabled or Disabled. The default is Enabled, which uses 
Microsoft Office when converting certain types of documents. In the 
Disabled state, Kurzweil 1000 uses Stellent’s Outside In™ 
technology.
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More File Enhancements
Table Support for HTML and DAISY files. When saving 
documents in HTML or DAISY format, Kurzweil 1000 now 
preserves any tables that are in the original.

Play More Audio Files. With Version 11, you can open and play 
DAISY Audio 2.02 books, and MP3, WAV, and Windows Media 
(WMA) files directly in Kurzweil 1000. If there are human voice(s) 
and/or music used on the original recording, that’s what you’d hear. 
While in these files, you can: 

• Use Reading and Navigational keys as you would in any 
document. If the DAISY audio book has page numbers, you can 
use the Page keys for navigation.

• Annotate the MP3, WAV and WMA files by using Bookmarks or 
Notes, and use Bookmarks for navigation as well. (This is not 
available for DAISY files.)

Opening Recently Opened Files. Now Kurzweil 1000 keeps track 
of up to 10 of the files you have opened in a session. Their 
mnemonics are 1 through 9, 1 being the most recently opened file. 
The number one is also designated for the tenth item.

Extracting All Images. There may be circumstances where you 
wish to create image files that correspond to the pages in a 
particular document. You can do so with either the existing Extract 
Image command which stores a single page image or Extract All 
Images, mnemonic X, for all pages in a file. Both are in the File 
Utilities submenu, mnemonics ALT+F, then U.
In the File dialog, specify a name for the file or folder in which the 
image should go. Kurzweil 1000 stores the images as TIFF files. If 
you used Extract All Images, the individual files are named using 
the first five characters from the document name, followed by a 
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four-digit page number, with leading zeroes, if necessary. Once 
Kurzweil 1000 completes creating the files, it will notify you. 

Note: For either command, be sure you have Keep Images enabled 
in General Settings before scanning so that there is an image 
associated with each page. 

HumanWare Maestro support. To send files to Maestro, first dock 
the Maestro and verify connection. Choose Send To from the File 
menu. In the File dialog, select the desired files and press Enter. 
Next select Maestro from the Devices list, then press ALT+R to go 
to Properties. In the Properties dialog, TAB to the Files Format 
list, and select a file format. Press Enter two times.

Note: The DAISY file format is for DAISY 3 documents. To send 
Audio DAISY files, copy the files from outside of Kurzweil 1000.
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Enhancements to Document Exploration 
Searching for Blank Pages. You can now find blank pages, that is 
pages that contain no displayable text. Note, though, that a blank 
page may have spaces, tab and new line characters.

In the Format list (ALT+O) in the Find dialog, type the letter B until 
you hear "Blank Pages." You can use ALT+N to search forward or 
ALT+V to search backward.

Enhanced Explore Layout. When you choose Explore Layout 
from the Tools menu, you will find new categories of "text regions" 
that are designed to help you better discern what’s in a document. 
A text region might be one of the following: table, header, footer, 
caption, title or text block. You’ll hear the name of the category and 
the page number on which it is found. 

There is also a new button in the Explore Layout dialog, labeled 
Extract. If activated when the current grid row is for an image 
region, a File dialog opens, in which you can give the name of the 
TIFF file you want the image to go into. You can activate this 
command from the grid by pressing CONTROL+E.

New Dictionary Lookup Features 
Eighteen Bilingual Dictionaries. Now you can look up words in 
any of 18 bilingual language dictionaries, including AHD English to 
Spanish, Larousse Concise French to English, and LSI Dutch to 
English, and LSI English to German or Italian. The dictionaries are 
in the Dictionary Source list in the Define a Word dialog, which is 
accessible from the Tools menu. If you have the language voice 
installed, Kurzweil 1000 reads the definition in the appropriate 
language; if not, it will use the system voice. All dictionary shortcuts 
are applicable when using the bilingual dictionaries, except for 
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Read and Spell, in which case, you must use SHIFT+RIGHT 
ARROW to spell and CONTROL+Y to read the selection. You can 
save a bilingual language selection in a Settings file for quick and 
convenient access.

Suggestions for Misspelled Words. When using Define a Word, 
and the Dictionary is unable to find the word you specified, it will 
suggest another one based on words that have a similar spelling. 
For instance, if you look up the word, "braile" using only one "l," the 
dictionary will ask if you mean the word, "braille," containing two l’s.

Copy Whole Dictionary Definition. Once you have a definition, 
you can press CONTROL+W to copy it to the clipboard and paste it 
into any other document, even one in another application.

Two More Parts of Speech when looking up words. It is now 
possible to search for Slang when using the American Heritage 
Dictionary and Plural Nouns when using American Heritage or 
Concise Oxford.

Changes to Dialog Box Features
Continuous Reading in Dialog Boxes. By pressing the F5 key 
while in Lists or Treeviews, Kurzweil 1000 reads continuously from 
the current selection to the end of the list. In a Treeview, Kurzweil 
1000 expands an item and reads its subitems, as the cursor 
progresses down the list. To stop continuous reading in dialog lists, 
press any key.

Automatically Read Punctuation in Dialogs. You’ll find that for 
certain lists in dialogs, such as the Spelling dialog, Ranked Spelling 
dialog, Edit Word List dialogs and in all File lists, that Kurzweil 1000 
will speak punctuation.
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Additional Changes and Enhancements
1. New Features Guides for multiple versions of Kurzweil 1000 are 

now available in the Help menu: press ALT+H, then N, and 
select the version you want.

2. Keypad addition for switching currently active document. While 
using the Kurzweil 1000 Reading Keypad Layer, you can press 
SHIFT+UP ARROW, also known as the 8 key, to change the 
currently active document.

3. Get Time and/or Date. Pressing CONTROL+T in the past would 
give you the time followed by the date. Now, press it once to 
hear the time, press it twice to hear the date. 

4. Ability to create a list of misspelled words when using Ranked 
Spelling. With the cursor in the Ranked Spelling list, you can 
press CONTROL+C to copy the list to the clipboard, ready to 
paste into a new document in Kurzweil 1000 or in another 
application.

5. The ability to hear menu items spelled aloud by pressing 
CONTROL+L and CONTROL+SHIFT+L.

6. Changed Scanner Threshold default. In the Scanning Settings 
tab, the Thresholding option now has Dynamic rather than 
Static as the default.

7. Changes to Font Properties dialog. In Version 11, the Font 
Format dialog includes Bold and Italic. You can either Enable 
or Disable them. Note: If you have text selected and the 
selection includes a multiple styles, any or all of the properties 
in this dialog can be "Mixed."

8. Settings changes. Maximum Text Length in General Settings 
has been taken out now that we’ve replaced it with options in 
Conversion Settings. Saving Partial Settings dialog box now 
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includes the Conversion, so that you may save Conversion 
settings.

9. When you set Verbosity for Top of List, Bottom of List, and 
Position of an Item in a List, they now take effect in Kurzweil 
1000 applications: Appointment Calendar, Calculator, Fax and 
Photocopier.

10.Verbosity Events now include Reading Past Form Field, 
Completion of a Long Recognition Task, and Completion of 
Audio File Creation.

11.Merriam-Webster’s Medical Dictionary has been added to the 
list of selections in Use an Encyclopedia on the Online menu.
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Systems Code 
Worksheet

If you are installing and registering Kurzweil 1000 from multiple 
machines, and are using the phone registration option, completing 
the worksheet provided on the next page before calling Customer 
Service can help to expedite the process. 

As you go through the installation process note these numbers for 
each machine. They are necessary for obtaining a corresponding 
unlock code, which you will then need to activate each installation 
of the software. 

Space is also provided on the worksheet for the location of each 
machine, and for the corresponding unlock code which the 
Customer Service representative will provide to you. 

For complete details and instructions on product registration, and 
specifically, Registering by Phone, go to Installation and 
Registration at the front of this Guide. 
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Machine Location Serial Number Systems Code Unlock Code



Systems Code Worksheet

Machine Location Serial Number Systems Code Unlock Code
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